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1 Introduction

The ADSS Server's regular release provides a more systematic and comprehensive update package that
entails applying the updates to the existing base version of the ADSS Server. The update process often
requires clients to undertake several steps, such as file removal, data backup, and more. With multiple
instances of the server in operation, this process can become complex and prone to errors for our clients.
Running the ADSS Server installer, which will automatically handle all necessary tasks—upgrading the
database, backing up code, removing outdated files, and installing new ones. This approach aims to simplify
the update process, reduce the likelihood of errors, and ensure more efficient and reliable system
maintenance.

1.1 Scope

This manual describes how to install one or more instances of ADSS Server Regular Release.

1.2 Intended Readership

This manual is intended for ADSS Server administrators responsible for installation and initial configuration.
It is assumed that the reader has a basic knowledge of digital signatures, certificates and information
security.

1.3 Conventions
The following typographical conventions are used in this guide to help locate and identify information:

e Bold text identifies menu names, menu options, items you can click on the screen, file names, folder
names, and keyboard keys.

e Courier New fontidentifies code and text that appears on the command line.

e Bold Courier New identifies commands that you are required to type in.

1.4 Technical Support

If Technical Support is required, Ascertia has a dedicated support team. Ascertia Support can be
reached/accessed in the following ways:

Website https://www.ascertia.com
Email support@ascertia.com
Knowledge Base Ascertia Community Portal

In addition to the free support services detailed above, Ascertia provides formal support agreements with all
product sales. Please contact sales@ascertia.com for more details.

When sending support queries to Ascertia Support team send ADSS Trust Monitor logs. Use the Ascertia’s
trace log export utility to collect logs for last two days or from the date the problem arose. It will help the
support team to diagnose the issue faster. Follow the instructions on how to run the trace log export utility
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2 System Requirements
To view the system requirements for ADSS Server, navigate to the link below:

ADSS Server (ascertia.com)

2.1 Typical Deployment Scenario

A typical ADSS Server installation schematic looks like this:
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Figure 1 - Typical ADSS Server Deployment Scenario

ADSS Server and the database it uses can both be installed on the same machine. 12GB RAM is
recommended for such a scenario. For high performance environments, it is recommended to install them
on separate systems.

The details shown above are the minimum system requirements; these may need to be revised to meet
specific usage requirements. For high throughput systems consider using multiple load-balanced ADSS
Servers in a network load-balanced resilient arrangement. Multiple physical CPUs can be added although
additional licenses are required for these. Virtualized systems are also supported.

ADSS Server can also be installed on the same system as the business application it services.

2.2 HSM Support for Key Wrapping

If you wish to use ADSS Server with its HSM based user key generation wrapping and export under a static
or dynamic KEK then be careful with the specifications of the HSMs you order or try to reuse.

The best thing to do is to run the ADSS Server PKCS#11 Test Utility to check if the HSM supports the
mechanisms needed for this and indeed other functions. HSM vendors are known to change the
mechanisms that are supported in this area, and some exclude such mechanisms from the allowable list
when in FIPS 140-2. If in doubt check with Ascertia support and also check with your HSM vendor that the
AES_CBC_ENCRYPT_DATA mechanism is supported for key wrapping and export.
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3 Pre-Installation Checks
The below-mentioned points must be ensured before installing the regular release for ADSS Server v8.3.x:

e The ADSS Server v8.3.1 must be installed. The regular release can only be applied to ADSS Server
v8.3.1 and NOT to the prior versions.

e When the ADSS Server is operating in a load-balanced mode, it is essential to upgrade all nodes
to version 8.3.1 before applying the Regular Release.

e The operator must take the database backup of ADSS Server v8.3.1. To view more details regarding
the backup procedure, navigate to the ADSS-Server-Backup-and-Restore-Procedure-for-
Application-and-Database.pdf document at available in the [ADSS-Server-Home]/docs folder.

e The ADSS Server instances must also be stopped before installing the regular release package.

3.1 Installation of RNG Tool on Linux System

After installing ADSS Server 8.3.1 on a Linux RED HAT 8.9 machine, users may encounter an issue where
they are unable to access the ADSS Server console after restarting the services from Linux commands.
Even if the machine itself is restarted, the problem persists upon restarting the ADSS Server service.
Additionally, the console may become unresponsive intermittently during usage. Upon analyzing the SSL
Debug level logs, users may observe the following message:

javax.net.ssl|ALL|51|C3POPooledConnectionPoolManager[identityToken-
>2ujiuhb3edsqz01f2rwkg|32b42115] -HelperThread-#2|2024-05-01 15:07:34.324
GST|SSLContextImpl.java:119|done seeding of SecureRandom

The error occurs due to the absence of the Random Number Generator (RNG) Tool on the Linux system
where the ADSS Server is installed. The RNG Tool is a set of utilities related to random number generation
in the kernel.

To resolve the issue, follow these steps to install the RNG Tool:
1) Open a terminal or command prompt on the Linux machine.

2) Run the following command to install the RNG Tool.
yum install rng-tools -y

3) Startthe RNG Daemon service using the following command.
systemctl start rngd

4) Enable the RNG Daemon service to start automatically on system boot.

systemctl enable rngd

After installing the RNG Tool and starting the RNG Daemon service, restart the ADSS Server services and
verify if the issue persists. Users should now be able to access the ADSS Server console without
encountering any further problems.

NOTE: The more comprehensive details of pre-installation checks have been described in details in Section
3 of the ADSS-Server-Installation-Guide document. To view details, navigate to the [ADSS-Server-
Home]/docs folder.
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4 ADSS Regular Release Installation

ADSS Server is a Java 17 EE application that has rich functionality. The ADSS Server license file contains
a list of services/modules licensed for you, so not all services may be available within your ADSS Server
deployment.

ADSS Server is shipped with a customized distribution of Apache Tomcat and Java and Ascertia continues
to periodically upgrade these to the latest available versions. Operators and administrators should not
attempt upgrade to these separately because it will lead to a system configuration that is not supported by
Ascertia. If an upgrade is required, raise it to Ascertia at support@ascertia.com.

ADSS Server can be installed in either of these modes:
e GUI based - for Windows/X11 platforms

e Command Line (Non-GUI based) - for remote installation on UNIX platforms

4.1 Installation Process

ADSS Server regular release installer must be unzipped to a suitable directory (later referred as [ADSS-
Server-Home]). ADSS Server regular release installation directory path MUST NOT contain space
characters otherwise the installer will not be launch.

To start the installation, navigate to [ADSS-Server-Home]/setup directory. Either using a command line or
Windows GUI interface.

Windows

Run the install.bat file under administrative privileges, as shown below, (otherwise ADSS Server services
will not be registered in Windows Services Panel) to launch the installer.

= hmar £ ransa a0 an ppg
&) insta DFTEH T
|7 insta Edit -1
2 | reads — 1

: i
| setur % Run as administrator »

|| setug Troubleshoot compatibility 1

Figure 2 - Windows Example Installer Run as administrator

UNIX
To install ADSS Server Regular Release on UNIX systems the installer must be launched under root user
privileges (otherwise ADSS Server daemons will not be registered in /etc/systemd/system). Click here to
read how to change the owner and group once the installation has completed. Use the following command
to mark install.sh file as executable before launching:

$ chmod + x install.sh
The following command will kick off the installer in GUI mode:

$ sh install.sh

The following command will run the installer in Headless Mode (Non-GUI):

$ sh install.sh headless
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The installation wizard will guide you through the various steps to ensure a complete and correct deployment
of ADSS Server is achieved. These are detailed next in the upcoming sections. Three services will be
registered in Windows Services Panel or /etc/systemd/system on UNIX.

In case of Ubuntu OS, we will use the following commands:
1. The following command will kick off the installer in GUI mode:

i i 8 bash install.sh

2. The following command will run the installer in the Headless Mode (Non-GUI):

S bash install.sh headless

ADSS Server is not installed as a single Windows NT service or a Unix daemon. A standard
installation of ADSS Server is comprised of three components:

ADSS Core, ADSS Console and ADSS Service.

0 Each of these components uses a separate JVM. For a standard installation of ADSS Server
all three components is installed on one machine. For a custom installation, it is possible to
install the components on separate machines. It is possible to install multiple ADSS Core, and
ADSS Console instances for high availability, together with multiple ADSS Service instances

to load-balance the service requests for higher throughput.

4.2 Installation Steps

ADSS Server uses dynamic master key to ensure protection and security of data. To generate a dynamic
master key, ADSS Server provides multiple mechanisms to its users that are categorized into different key
types. These includes:

e Software based key — Auto Startup
e Software based key with M of N controls — Manual Startup
e Hardware based key — Manual Startup

The desired key type will be selected according to the requirement. The details of each key type is explained
below:

4.2.1 Software Based Key — Auto Startup

In this scheme, master key is generated using a software crypto source and protected by ADSS Server.
Master key can be renewed after regular intervals in order to ensure security. Here, the master key will be
protected by ADSS Server itself hence ADSS will be started without any operator’s intervention.

Running the install.bat/sh file located at [ADSS-Server-Home]/setup directory shows the following
screen;
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ADSS Server Installation Wizard - Welcome to Ascertia's Secure Digital World X

Welcome to ADSS Server the most advanced trust services platform for:
* Document and Data Signing Services

* Document and Data Verification Services

* User and System Identity Management Services

* Digital Certificate Validation Authority Services

* Timestamp Authorty Services

* Key and Digital Certificate Generation Services

1 headiess

* Long-term Archiving & Notary Services

We recommend you to read these guides at this point
* ADSS Server Instalation Guide

* ADSS Server Admin Guide [Concepts and Archicecture]

U.S. Patent No. 7,360,079

Cancel Next >

I Advanced Digital Signature Services (ADSS)

Clicking Next > shows the following screen:

ADSS Server Installation Wizard x

License Agreement
ASCERTIA SERVER SOFTWARE LICENSE AGREEMENT -
IMPORTANT - PLEASE READ CAREFULLY: E
1.0 ACCEPTANCE.
B Ascertia Limited ("Ascerta”) is willng to license this software (the Software) and
3 documentation (together the Product) in this nstalation package to you as an
indwidual or as an authorised representative of the company or lkegal entity that
A wil be using the Software only on condtion that you accept all of the terms of

this lcense agreement. You or the company or legal entity (referred to as the
Licensee) can accept the terms of this License Agreement by clicking on the "
agree” button below, and proceed with the instalation. To reject the terms of
this License Agreement, clck on the "Cancel” button below and ext the
installation process and make no further use of the softuare.

BY INSTALLING AND USING THIS ASCERTIA SOFTWARE, YOU AGREE FOR YOU
OR YOUR ENTERPRISE TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF
YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL
OR USE THE ASCERTIA SOFTWARE.

Licensee and Ascertia may hereinafter be referred to as ndividualy, a "Party”,
or, together, the "Parties.”

1disagree Iagree

If you agree with the displayed terms and conditions, then click “I agree” to continue the installation process
otherwise click “I disagree” to stop the installation process.

Clicking | agree shows the following screen:

ADSS Server Regular Release Det:

New Features: -

- Regular Release installer - (ADSS-20751)

ADSS 8.3.2 ntroduces a streamined installation for regular releases, alowing
users to seamlessly instal incremental updates comprising of new features,
improvements and bug fixes. This offers smplfied instalation procedures, such
as automated backup, smooth fle replacement, executing database scripts,
guaranteeing a frictionless instalation flow and the abilty to revert changes in
the event of falures

New Enhancements:

- Migration from .NET framework 4.5 to .NET Core 8.0 - (ADSS-20454)
ADSS Server Clent SDK has been migrated from .NET framewark (4.5)
core (8.0)

o .NET

- Upgraded Tomcat - (ADSS- 20782)
The ADSS Server has been upgraded tomcat from v9.0.76 to v9.0.83

- 2rA marty indatas - (ANCE. 20702

Cancel < Back Next >

This screen shows the details of the regular release. To continue the installation process click on the Next
button, it will display the following screen:

© Ascertia Limited Commercial-in-Confidence Page 8 of 21



L
ascerfla

ADSS Regular Release - Installation Guide Tinexta Infacert

Existing ADSS Server Configurations

Select Existing ADSS Server Directory
D:/v8.3.2/ADSS/ADSS-Server-v8.3.1-Win64-24Nov2023

A / Browse |
E— Select Backup ADSS Server Directory L

§ D:/v8.3.2/ADSS

gital Signature Services (ADSS)

Note :- Browse
L

1 - Ensure you have stopped ADSS Server instances
2 - Ensure you have backed up the ADSS Server database

\dvanced Di

] ]
Cancel || <Back || Instal

The above screen allows the user to get the existing ADSS Server Directory and Backup ADSS Server
Directory from the file system. After the directories are uploaded, the regular installer determines that the
uploaded ADSS Server file is either ‘Software based key — Auto Startup’, ‘Software based key with M of N
controls’, or ‘Hardware based key’.

If the uploaded ADSS Server file is ‘Software based key — Auto Startup’, then the installation will be
continued as per the traditional mechanism. However, if the uploaded ADSS Server file supports ‘Software
based key with M of N controls’ mechanism, then refer to the section below:

4.2.2 Software Based Key with M of N Controls — Manual Startup

In this mode, the Master Key is generated using a software crypto provider and split according to M of N
rule. The minimum value of M will be 2 and N will be 3. The maximum value of M of N will be 16.

The below screen allows the user to upload the generated master keys for the uploaded ADSS Server
directories:

Import ADSS Server Master Key Components

ADSS Server wil use a local Master Key to protect senstive data. To
rebuid the ADSS Server local Master Key you need to import its
individual components that you back-up previously. Click the

Import button for each component to proceed.

Import Master Key Component 1 Import
Import Master Key Component 2:

Import Master Key Component 3:

4"Qg_yam:ed Digital Signature Services (ADSS)

Cancel < Back

While importing the master key, the operator will be asked to set a password for it:
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W

Import Master Key Component 1:

Import ADSS Server Master Key Components

ADSS Server wil use a local Master Key to protect sensitive data. To
rebuid the ADSS Server local Master Key you need to import ts
individual components that you back-up previously. Cick the

Import button for each component to proceed.

s Q'//

I (RGP Password:

[ OK | Cancel

Advanced Digital Signature Services (ADSS)

Cancel

< Back

Itis recommended to set a different password for each master key. Once all the master keys are successfully
imported, the below screen will be displayed:

Import ADSS Server Master Key Components

ADSS Server will use a local Master Key to protect senstive data. To
rebuid the ADSS Server local Master Key you need to import its
individual components that you back-up previously. Click the

Import button for each component to proceed.

Import Master Key Component 1:

Import Master Key Component 2:

gital Signature Services (ADSS)

Import Master Key Component 3:

Cancel

~ Advanced Di

Import Q//
Import Q,//
Import J

< Back H Next >

After importing the master keys, click on the Next button, the installation will continue as per the traditional

mechanism.

If the uploaded ADSS Server file supports ‘Hardware based key’ mechanism, then refer to the section below:

4.2.3 Hardware Based Key

— Manual Startup

In this mode, a key is created inside an HSM that is used as Master Key for ADSS Server. Below screen
will be displayed during the installation process:

© Ascertia Limited
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Existing ADSS Server Configurations

-

n

[}

Q

<

i Select Existing ADSS Server Directory

@

i

g = Enter PKCS#11 Credentials X

w

@

5 Crypto Source Vendor:  Thales

2 I
Sele

E- Interface Type: Luna PKCS#11

2

i PKCS#11 Module:  cryptokidl

2

! PKCS#11 Skt: 2

=]

= fo PKCS#11 PIN:

8 1

o 2-

2

The above screen will allow the operator to PKCS#11 PIN in order to establish the connection with the HSM.

Afterwards, the installation will be continued as per the traditional mechanism. To view more details
regarding the ADSS Server installation, refer to ADSS-Server-Installation-Guide located at [ADSS-Server-
Home]/docs directory.

4.3 Installation using Silent Mode

For Installation in Silent Mode, we have an finstall.xml’ file located [ADSS-Server-Installation-
Directory]/setup folder. It is an xml file that can be opened in Notepad (or Notepad ++). The file contains all
the necessary options that are required for the Installation of ADSS Server, but in XML format. The operator
can edit the file, fill in all the required fields as per its requirement (same as GUI or Headless mode) and
proceed with the Installation.

In order to install ADSS Server in Silent Mode, follow the steps below:

1. Navigate to [ADSS-Server-Installation-Directory]/setup

2. Open ‘install.xml’ file with Notepad++

lang Do
il Edit
i
|cer15|e ) Share with Skype
samples r
) P L| Edit with Motepad++ I,}
script
F;. " i Ea Scan with Microsoft Defender...
| configuration.propertie
& Sh
[E] install.bat = are _
J install.xml Open with ?
W readme.html SRR
[E] uninstall.bat %5 TortoiseGit s
| oot
= Weleame 'Y TortoiseSVN 5

3. Once the file is open, it displays the following screen:
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<2zl version="1.0" encoding="UTF-8"2>
<Wizard>
<Welcome visible="true"/>
<LicenseAgreement visible

truen>

<Agree>TRUE</Agree> <!-- possible values are TRUE/FALSE

</Licensehgreement>
<InstallationMode visible="true">
<Mode masterKey=rgeneratem>FIRST_TIME</Mode> <
values for masterey are generats,import —-»
</InstallacionMode>
<GenerateMK visible="true"s
<Assurancelevel>1</Assurancelevel> <!-— possible
controls - Manual Startup, 3=Hardwars based key -
<MofN>2-3</MofN>
Default value 2-3 and Maximum value 16-16 -->
<HsmVendor></HsmVendor>
<InterfaceType></InterfaceType>
ENTRUST_NCIPHER (THALES/THALES_CC) and for OTHER
<Pkos1lModule></PkesliModules
<Fkcs115lot></Pkcsllslots>
<PkesllPin»</PkcsllPin>
<Pkes11UserTd></PkesllUserId>
<Pkes11UserPin></PkesllUserBin>
<MasterKeyAlias></MasterKeyAlias>

KPrivate></ KAKPrivate>
oﬂy required when Mode is LOAD BALANCE/EXISTING I
<MasterKeyKAKPublic></MasterKeyKAKPublic>

Only reguired when Mode is LOAD_BALANCE/EXISTING |

</GenerateMK>

<ManagingMK visible="true">
<MbkPathl password=""></MbkPathl> <!-
(LOAD_EALANCE/EXISTING_DATABASE) -->
<MbkPath? password=""></MokPath2>
<MokPath3 password=""></MokPath3>
<!-- N number of paths will required here, only
<1-—<MbkPathd password=""></MbkEachd>-—>
<!--<MOKPathS Password=""></MbkPach5>-—>

</ManagingHK>

<InstallDirectoryPath visible=ntrue"/>

<PreferredIpVersion visible="true">
<IpVersion>TPvé</IpVersion> <!-- possible values
<!-- Provide IPv4/IPvé address accordingly, If I
<Iphddress></Iphddress>

</Preferredlpversion>

<HostName visible="true">

Same atcr

<l-- Provide pgstpame accordingly, If Rost name is not defined then installer will pick System’'s hOSt name:
<Host></Host>
</HostName>

<!-- upgrading screen-—>

<ExistingIlnstallation visibl "true">
<!--<Path>EXISTING ADSS_INSTALLATION DIR</Path>-
<BackupDirsctory>

<Path>BACKUP_DIRECTORY</Path>-—>
</BackupDirectory>
</ExistingInstallation>
<LicenseOption visible="trus">
<Option>EVALUATION</Option> <!
</LicenseOption>
<LicenseFilePath visible="true">
<l--<Path>../core/license. gml</Batho--><!
</LicenseFilePath>
<LicenseType visible

truen>

Backup directory path in case of regular release install path

possible values are FIRST TIME/LOAD BALANCE/UPGRADE/EXISTING DATABASE/REGULAR RELEASE, Possible

walues 1/2/3, These denote to 1=Software based key - Auto Startup,2=Software based key with M of N
Manual Startup Default 1-->
<!-- (M of N rule 2 of 3, only required for Software based key with M of N controls) Minimum and

4!-- possible values are UTIMACO/THALES/ENTRUST_NCIPHER/OTHER only required for Hardware bassd key—->

<!-- possible values When HsmVendor is UTIMACO (UTIMACG/UTIMACO CPS), THALES(SAFENET/SAFENET CC),
(OTHER) only required for Hardware based key-->

- PKCS$11 driver library file name/complete path for this hardware device —>

- appropriate PECS#11 slot no -—>

- PIN or password for the slot chosen —->

- Specify the User ID for the Grypty User, only required for UTIMACO_CPS Interface Type

- Specify the PIN for above Grypty User, only required for UTIMACC CPS Interface Type—-—>

>

<!-- Specify the Master key Alias(value of Key_alias found in gopf/adss_startup.properties file), Only
Zequized wnen Mode 15 LOAD BALANCE/EXISTING DATABASE or masterXey='import'

<!-- Specify the HESEEX key KAK private(value of Kak_pr found in ggnf/adss_startup.properties file) ,
DATABASE or maste: ='import'-->

~ Specify the Master key KAK Public(value of Kak pu found in gopf/adss_startup.properties file) ,
DATABASE or masterKey='import'-->

4

ibutes are require either for backup (FIRST_TIME/Prior 6.0 UPGRADE) or for import

for 2 Assurancelevel -->

are IPve/IPvé -->

P address is not defined then installer will pick System's IP address——>

possible values are COMMERCIAL/EVALUATION —->

license file path-->

<Type>FULL_ADSS_SERVER</Type> <!-- possible values ar:
FULL_ADSS_SERVER/DCCUMENT_SIGNING VERIFICATION/EID_VALIDATION/TIMESTAMPING ARCHIVING/PKI_INFRASTRUCTURE -->

</LicenseType>

<SampleData visible="true">
<Insert>TRUE</Insert>

</SampleData>

<DatabaseConfiguration visible="true">

<DatabaseType>MSSQL</DatabaseType> <!-- possible values are MSSQL,AZURESQL, PGSQL,ORACLE,MYSQL —
possible values are TYPICAL/ADVANCED -->

<Configuration>TYPICAL</Configuration> <!
</DatabaseConfiguration>
<TypicalDatabaseConfiguration visible="true">

<MachineName></MachineName>

<Port>1433</Port>

<Authentication></Authentication> <!-- possible

<DatabaseName></Databasslans>

<UserId></UserId>

<Password></Password>
</TypicalDatabaseConfiguration>
<AdvancedDatabaseConfiguration visible="true”>

<Userld»</UserId>

<Password></Password>

<JDBCURL></JDBCURL>

Values are SERVER AUTH, WINDOW_AUTE

<1-- Use the advanced JDBC URL for one of the PostgresQL, SQL Server, Azure SQL, Oracle and MySQL accordingly -->
<!--<JDBCURL>jdhs : Rostarsagl: / /<DATABASE MACHINES:5432/<DATABASE NAME></JDBCURL>-->

<1--<IDBCURL>3gbS : $a12SE¥ex : // <DATABASE MACHINE>:1433;databaseNam
<!--<JDBCURL>jdk¢: #qd355¥s% s // <DATABASE MACHINE>;datab

<DATABASE_NAME ></JDECURL>
DATABASE_NAME></JDBCURL>-->

<!--<JDBCURL>jghg oracle: thin: @<DATABASE MACHINE>:1521:<DATABASE NAME></JDBCURL>-->
<!--<JDBCURL>3deg:mariadh: / /<DATABASE MACHINE>:3306/<DATABASE_NAME></JDBCURL>-->

</hdvancedDatabassConfiguration>
<InstallMode visible="true">

<Mode>TYPICAL</Mode> <!-- possible values are TYPICAL/CUSTOM

</TnstallMode>
<CustomInstallation visible="true">
<Core>TRUEC/Core>
<Console>FALSE</Console>
<S1gning>FALSE</Signing>
<Verification>FALSE</Verification>
<Certification>FALSE</Certification>
<GCSP>FALSE</OCSP>
<TSA>FALSE</TSA>
<XEMS>FALSE</XRMS>
<LTANS>FALSE</LTANS>
<SCVP>FALSE</SCVP>
<Decryption>FALSE</Decryption>
<TSLMonitor>FALSEC/TSLMOnitor>
<CRLMonitor>FALSE</CRIMonitors>
<GoSign>FALSEC/GoSign>
<CCSPMonitor>FALSES/OCSPMonitor>
<GCSPRepeater>FALSE</OCSPRepeater>
<RA>FALSE</RR>
<RASYFALSE</RAS>
<SAM>FALSEC/SAM>
<CSP>FALSE</CSE>
<HMAC>FALSE</HMAC>
<SPOC>FALSE</SPOC>
<NPKD>FALSE</NPED>
</CustomInstallation>
<MemoryConfiguration visible=
<x86>
<CoreLimit>1024</CoreLimit>
<ConsoleLimit>1024</ConsoleLimit>
<ServicesLimit>1536</ServicesLimit>
</%86>
<xé4>
<CoreLimit>1024</Corelimit>
<ConsoleLimit>1024</ConsoleLimit>
<ServicesLimit>2048</ServicesLimit>
</x64>
</MemoryConfiguration>
<ProgressFrame visible="true"/>
<ServiceConfiguration visible="true">
<InstallAsService>TRUE</InstallhsService>
<StartService>TRUE</StartService>

"Crusn>

<InstallDefaulcAdminPFX>TRUEC/InstallDefaul tAdminPEX>

<Comput eHMAC>TRUE </ ComputaiMAC>
</ServiceConfiguration>
<UpgradeSummary visible=ntrae"/>
</Wizard>
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4. The above image shows the contents of the file. The operator need to fill in the required information
according to its requirement in the respective xml fields.

v

For installation in Silent Mode, we need to set the <visible =
to FALSE (wherever true) in xml file.

”

> attribute value

Fill out the information in xml file as mentioned below:
a. Set License Agreement tag to ‘true’ if you agree with the displayed terms and conditions.
Otherwise set ‘false’ to stop the installation process.
b. As explained earlier, there are various installation modes available in ADSS Server. To set
the mode of installation and master key, we have <InstallationMode> tag in install.xml file.
An operator can either generate new or import an existing Master Key and select the

required

installation option in via this tag. Possible values are FIRST_TIME,

LOAD_BALANCE/UPGRADE, EXISTING_DATABASE and REGULAR_RELEASE.

c. The next step is to set the type of master key that is to be generated. We will set all the
required properties of master key in <GenerateMK>. The list of properties inside this tag
are explained below:

Vi.
Vii.
viii.

Xi.

Xii.

Use <AssurancelLevel> tag to set the type of master key to be generated. Here,
possible values are 1,2 and 3 where:

= 1 represent Software based key - Auto Startup,

= 2 represents Software based key with M of N controls - Manual Startup,

= 3 represents Hardware based key - Manual Startup
All these key types have been explained in the section 4.1.1. Default value is 1.
Use <MofN> tag to define the M of N rule. It will only be used when Software based
key with M of N controls is selected. Default value is 2-3 and maximum value is 16-
16.
Use <HsmVendor> tag to define the required HSM. It will only be used in case of
Hardware based key — Manual Startup. Possible values are UTIMACO, THALES,
ENTRUST_NCIPHER and OTHER.
Use <InterfaceType> tag to define the interface type of the selected HSM. It will
only be used in case of Hardware based key — Manual Startup. Possible values are
UTIMACO (UTIMACO/UTIMACO_CP5), THALES(SAFENET/SAFENET_CC),
ENTRUST_NCIPHER (THALES/THALES_CC) and for OTHER (OTHER).
The <Pkcs11Module> tag is used to define the PKCS#11 driver library file name or
the complete path for the selected hardware device.
The <Pkcs11Slot> tag is used to set an appropriate PKCS#11 slot number.
The <Pkcs11Pin> tag is used to set PIN or password for the chosen PKCS#11 slot.
The <Pkcsl1lUserld> tag is used to specify the User ID for the crypto user. The
User ID will only be set in case where UTIMACO_CP5 Interface Type is selected.
The < PkecsllUserPin> tag is used to specify the PIN for the above crypto user.
The User PIN will only be set in case where UTIMACO_CP5 Interface Type is
selected.
The <MasterKeyAlias> tag is used to specify the Master Key Alias. The value of
Key_alias can be found in conf/adss_startup.properties file. It is only required in the
case where Installation Mode is LOAD_BALANCE/EXISTING_DATABASE or
masterKey="import'.
The <MasterKeyKAKPrivate> tag is used to specify the Master Key KAK Private.
The value of KAK private can be found in conf/adss_startup.propertiesfile. It is only
required in the case where Installation Mode is
LOAD_BALANCE/EXISTING_DATABASE or masterKey="import'.
The <MasterKeyKAKPublic> tag is used to specify the Master Key KAK Public. The
value of KAK public can be found in conf/adss_startup.properties file. It is only
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required in the case where Installation Mode is LOAD_BALANCE,
EXISTING_DATABASE or masterKey="import'.

d. As mentioned in section 4.4.1, once the master key is generated, we need to take the
backup of the master key in the form of three components (or more if Assurance Level ‘2’
is selected) and encrypt them with the provided password. For this <ManagingMK> tag will
be used. Below tags will be used to set the password of master key components:

i The <MbkPathl password=""> tag will be used to set the password for first key

component.

ii. The <MbkPath2 password=""> tag will be used to set the password for second key
component.

iii. The <MbkPath3 password=""> tag will be used to set the password for third key
component.

e. The <InstallDirectoryPath> tag will enable the operators to see the directory where the
master key components are saved on the file system.

f.  The <PreferredlpVersion> tag is used to set the required IP version (IPv4 or IPv6) for ADSS
Server Installation.

i.  The <IpVersion> tag is used to set the required IP version.

g. The <HostName> tag is used to define the host name for ADSS Server. If the host name is
not defined, then the installer will pick up system’s default host name.

h. The <Existinglnstallation> tag is used in order to upgrade the current version of ADSS
Server. The operator will need to provide the current directory path inside the existing
installation tag.

Please note that when upgrading from the current version to the next version of ADSS
Server in silent mode, only the tags shown in the screen below should be used:

-->

s are FIRST_TIME/LOAD_BALANCE/UPGRADE/EXISTING_DATABASE, Possible values for masterKey are generate,import -->

reen -->

tallation visible="false">
\ADSS_Installations\ADSS_v7.1.1\ADSS-Server-v7.1-Win64-16Jun2@22-temp</Path>
I 1lation>
ation visible="false">
imit>1024</Co imit>
<Consolelimit>1024< oleLimit>
cesLimit>1536</ServicesLimit>

< imit>1024</Corelimit>
<Consolelimit>1024</
cesLimit>2048

nfiguration>
rame visible="false"/>

<UpgradeSummary visible="false"/>
</Wizard>

It is recommended to remove any tags not specified in the displayed screen to ensure a
smooth upgrade process.
i.  The <BackupDirectory> tag (located under Existing Installation) is used to specify
the Backup directory path in case of regular release installation.

i. The <LicenseOption> tag allows the operator to set the type of license to be used in ADSS
Server installation. The possible values are COMMERCIAL or EVALUATION.

j- The <LicensePath> tag allows the operator to set the path from where the license will be
uploaded from the files system for ADSS Server installation.
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k.

S.

The <LicenseType> tag allows the operator to set the features to be used (Full ADSS Server
or some specific modules) with the current ADSS Server installation. The possible values
are FULL_ADSS SERVER, DOCUMENT_SIGNING_VERIFICATION, EID_VALIDATION,
TIMESTAMPING_ARCHIVIN and PKI_INFRASTRUCTURE.

The <SampleData> tag is used to insert sample data in order to allow immediate testing of
ADSS Server.

i We need to set the <Insert> tag (under Sample Data tag) to TRUE in order to insert
the required sample data.

The <DatabaseConfiguration> tag allows you to set the required configurations relating to
the database type and configuration modes. It contains the following tags:

i The <DatabaseType> tag allows the type of the database that is to be used for
ADSS Server Installation. The possible values are MSSQL, AZURESQL, PGSQL,
ORACLE and MYSQL.

ii. The <Configuration> tag allows the operator set the type of configuration for the
selected database type. Possible values are TYPICAL and ADVANCED:

= Use <TypicalDatabaseConfiguration> tag to set the values for Machine
Name, Port, Authentication type (Server or Windows), Database Name,
User ID and Password.
= Use <AdvancedDatabaseConfiguration> tag to set the values for User ID
and Password. Also we need to set the advanced JDBC URL for one of the
PostgreSQL, SQL Server, Azure SQL, Oracle and MySQL accordingly.
The <InstallMode> tag allows the operator to set the installation mode i.e. whether the
operator wants to install all the components of ADSS Server i.e. TYPICAL or install all the
components of ADSS Server with custom memory parameters i.e. CUSTOM.
The <Customlnstallation> tag allows the operator to set the selected ADSS Server
components and service modules with custom memory parameters.
The <MemoryConfiguration> tag allows the operator to set memory limit for each instance
of ADSS Server i.e. Core Limit, Console Limit and Service Limit for both x86 an x64
systems.
The <ProgressFrame> tag allows the operator to track the progress of installation.
Under Service Configuration tag, make sure that the values of <InstallAsService>,
<StartService>, <InstallDefaultAdminPFX> and <ComputeHMAC> are set to TRUE.
Save and exit the xml file.

Launch the install.bat or install.sh file, the ADSS Server will be installed with the required set of
configurations of install.xml file.

4.4 Launching ADSS Server Admin Console

To access ADSS Server Admin Console, open a web browser (where you imported the Administrator PFX
above) and type the following URL:

https://{Machine-Name}:8774/adss/console

Where machine-name is one of:

e localhost (in a case when ADSS Server is accessed on the local system where it is deployed)

e Alocal network system name (e.g. adss-server-machinel)
e AnIP Address

e A URL (e.g. globaltrustfinder.com)

Initially you will be presented with a default TLS Client Authentication certificate that is pre-configured in
ADSS Server. It is recommended that you change this default certificate by creating/importing a new
certificate from ADSS Server Admin Console after login. Click here for more information. Note you can also
use certificates issued by third parties.
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Initially you will be presented with a temporary TLS Server Authentication certificate that is pre-configured
in ADSS Server. This is the default administrator certificate. You should change it by creating a new
certificate using the ADSS Server admin console. Refer to the ADSS Server Knowledge Base for more
details. Ascertia recommends creating at least two operators.

A popup dialog may be shown; listing TLS Client Authentication certificates installed in the browser
(including the one installed during ADSS Server installation) and asking you to choose appropriate
certificate. Choose the certificate with a common name of “ADSS Default Admin” to login the ADSS Server
Console.

adss_default_admin.pfx from [ADSS-Server-Homel/setup/certs/ directory in your web

i i Before launching the admin console, make sure that you have installed/imported
browser.

4.5 Uninstalling ADSS Regular Release

The uninstall option allows the user to revert back to the previous version of ADSS Server Regular Release.
Before starting the uninstall procedure, make sure that the user has taken the backup of the previous
version.

Backup-and-Restore-Procedure-for-Application-and-Database.pdf' document located in

i i For detailed information on backup and restore procedures, please refer to the 'ADSS-Server-
the [ADSS-Installation-Directory]/docs folder.

To start the uninstallation, navigate to [ADSS-Server-Home]/setup directory. Either using a command line
or Windows GUI interface.

Windows

To uninstall ADSS Server Regular Release on Windows platform, go to [ADSS-Server-Home]/setup
directory and run uninstall.bat file as administrator. This process will stop and then delete the registered
ADSS Server components from Windows Service Panel.

Name v Date modified Type Size

L:{ welcome.td TXT File 1 KB
J uninstall_solaris.sh SH File 1KB
j uninstall_linux.sh SH File 1 KB
[Z] uning— Windows Batch File 1KB
@ read|  OPO" . Chrome HTML Do... 2KB
@ menw EO . PROPERTIES File 1KB
o insta Print . XMLFile 4KB
7 insta G Run as administrator  SHFile 1 KB

Figure 3 - Windows Example Uninstall Run as administrator

Clicking on the ‘Run as administrator’ option shows the following screen:
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lvanced Digital Signature Services (ADSS)

* ADSS Server Uninstall Wizard - Welcome to Ascertia’s Secure Digital World X

ADSS Server Uninstall Wizard

Welcome to ADSS Server the most advanced trust services platform for:
* Document and Data Signing Services

* Document and Data Verification Services

* User and System Identty Management Services

* Digital Certificate Validation Authority Services

* Timestamp Authority Services

* Key and Digital Certificate Generation Services

* Long-term Archiving & Notary Services

‘We recommend you to read these guides at this point:
* ADSS Server Instalation Guide
* ADSS Server Admin Guide [Concepts and Architecture

U.S. Patent No. 7,360,079

Cancel Next >

Clicking Next > shows the following screen:

ADSS Server Uninstall Wizard X

License Agreement

ASCERTIA SERVER SOFTWARE LICENSE AGREEMENT -
IMPORTANT - PLEASE READ CAREFULLY: E

1.0 ACCEPTANCE.

Ascertia Limted ("Ascertia") is willng to license this software (the Software) and
documentation (together the Product) in this nstalation package to you as an
indwidual or as an authorised representative of the company or legal entty that
wil be using the Software only on condition that you accept al of the terms of
this license agreement. You or the company or legal entity (referred to as the
Licensee) can accept the terms of this License Agreement by clicking on the "I
agree” button below, and proceed with the nstalation. To reject the terms of
this License Agreement, click on the "Cancel’ button below and exit the
installtion process and make no further use of the software.

BY INSTALLING AND USING THIS ASCERTIA SOFTWARE, YOU AGREE FOR YOU
OR YOUR ENTERFRISE TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF
YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL
OR USE THE ASCERTIA SOFTWARE.

Licensee and Ascertia may hereiafter be referred to as individualy, a "Party”,
or, together, the "Parties.”

1disagree Tagree

If you agree with the displayed terms and conditions, then click “I agree” to continue the uninstallation

process, otherwise click “I disagree” to stop the uninstallation process.

Clicking | agree shows the following screen:

ADSS Server Uninstall Wizard

“Adyanced Digital Signature Services (ADSS)

Select ADSS Server Backup Directory

Browse
Select ADSS Server istallation Directory

Note :-

1. Ensure you have stopped ADSS Server Instances
2. Ensure you have restored the ADSS Server database

Cancel < Back

This screen allows the user to select the ADSS Server Backup Directory and the ADSS Server Installation
Directory from the file system to be uninstalled. After entering the required directory paths in the fields, click

the Uninstall button:
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gital Signature Services (ADSS)

\dvanced Di

L

Uninstall ADSS Server Configurations

-

Select ADSS Server Backup Directory

Pre Requisite Steps X 10523-111135

E Ensure the following is done before proceeding:

JE— Y

1. Ensure you have stopped ADSS Server Instances? ===
N 2. Ensure you have restored the ADSS Server ?

3. Ensure there is no ADSS Server files open in another program?

[es |
Note :- Browse

1. Ensure you have stopped ADSS Server Instances
2. Ensure you have restored the ADSS Server database

e e

After clicking the Uninstall button, a pop-up message will appear to ensure that you have completed all the
prerequisite steps before uninstalling the ADSS Server Regular Release. If you have completed these steps,
click the ‘Yes’ button to continue:

~ Advanced Digital Signature Services (ADSS)

ADSS Server Uninstall Wizard - X

Finalizing ADSS Server Uninstallation

ADSS Server regular release uninstal is in progress...

e

The above screen will show the progress of the uninstallation process. Once the uninstallation is completed,
the following screen will be displayed

Success

o

Li_(;l

X

ADSS Server Regular Release restored successfully

This screen shows that the ADSS Server Regular Release has been uninstalled successfully.

UNIX

To uninstall ADSS Server on a UNIX platform, go to [ADSS-Server-Home]/setup and run sh

uninstall linux.sh command accordingly under root user to delete registered ADSS Server
components from /etc/systemd/system.

Use the following command to mark uninstall.sh file as executable before launching:
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$ chmod + x uninstall linux.sh

The following command will run the uninstaller:

$ sh uninstall linux.sh

) On both Windows and UNIX platforms the uninstall procedure will not delete the directory
U structure and contents of ADSS Server, nor remove the database and its contents.

of a decommissioning exercise. This is not within the scope of ADSS Server and the relevant

> It is very important to securely delete any HSM held keys if the system is uninstalled because
u manufacturer will provide the necessary instructions to achieve this.

4.6 ADSS Server Service Interface URLSs

Once ADSS Server is installed you can use ADSS Server service interfaces to process requests from your
business applications. Interface URLs are documented in each service’s Interface URLs page in Admin
Guide. Each service has a unique URL and there are also variants for each depending upon which protocol
the client wishes to use e.g. OASIS DSS or HTTP protocol for signature operations.

4.7 Troubleshooting

If any of the ADSS Server Core, Console or Service components fail to start after installation or there is a
failure during installation wizard then ensure the following:

e Allow 1150 connections on your database server to allow ADSS Server to function at the
recommended capacity. Note the connection pooling ensures these are maximum values and will
not be created unless capacity demands it.

e The appropriate ADSS Server package for Windows/UNIX was chosen to install on the relevant
machine.

e There should be no space character anywhere in the ADSS Server installation directory path.

e ADSS Server should be installed with administrator/root user privileges.

e In case of Windows platform check the following services are found in Windows Services Panel.
o Ascertia-ADSS-Core
o Ascertia-ADSS-Console
o Ascertia-ADSS-Service

e In case of UNIX platform check that following service daemons are found within
/etc/systemd/system

o tomcatd-ADSS-core
o tomcatd-ADSS-console
o tomcatd-ADSS-service
o If ADSS Server does not start automatically after installation, then manually start ADSS Server;
start following services from Windows Services Panel on Windows OS:
o Ascertia-ADSS-Core
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o Ascertia-ADSS-Console
o Ascertia-ADSS-Service

On UNIX, use these commands to start the services:
o systemctl restart tomcatd_core_linux.service
o systemctl restart tomcatd_console_linux.service
o systemctl restart tomcatd_service_linux.service

o |If a certificate is not shown, then it is because of one of the following reasons:

o The browser settings are such that the certificate is automatically selected.
o There was a problem importing TLS client authentication certificate into the browser.

If Technical Support is required, Ascertia has a dedicated support team providing debugging, integration
assistance and general customer support. Ascertia Support can be accessed as described in Chapter 1.

The installation procedure produces a log file called install.log, which is located in [ADSS-Server-
Home]/setup directory. Any errors during installation will be recorded in this file.

Finally, consult the logs directory as each service produces its own unique log file.

4.8 Failure Event

In the event of a failure, an automatic restoration process for files is in place to ensure minimal disruption
and data loss. However, it's important to note that this automated recovery pertains solely to files and does
not extend to the database; hence, the database will not be restored.
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5 Post-Installation Notes

The post-installation notes have been described in details in Section 3 of the ADSS-Server-Installation-
Guide document. To view details, navigate to the [ADSS-Server-Home]/docs folder.

** End of Document ***
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